
License Agreement
BY INSTALLING THIS SOFTWARE YOU ARE AGREEING TO BE BOUND BY THE TERMS AND
CONDITIONS OF THE SOFTWARE LICENSE AGREEMENT SET FORTH BELOW. INSTALLING THIS
SOFTWARE INDICATES YOUR ACCEPTANCE OF THESE TERMS AND CONDITIONS. IF YOU DO NOT
AGREE TO THE TERMS, PROMPTLY RETURN THE FULL PRODUCT FOR A REFUND WITHIN 30 DAYS
OF PURCHASE.

Copyright

Published by Global Software Publishing, North America, Inc. (GSPNA) Copyright © 2002 Xamba
Software Ltd and United Soft Media Verlag GmbH. Maps copyright © 2002 Planetary Visions Ltd.
Country Data copyright © 2002 Dorling Kindersley Ltd. All rights reserved. No part of this software
and/or documentation may be reproduced, duplicated or distributed in any form without prior
written permission from GSPNA, whose registered address is 535 West 34th Street, New York, NY
10001. The Manual and CD are yours to keep, the software on the CD remains the property of GSP
Ltd.

License Grant

To use the program on a single machine. you may make a single back-up copy in support of your
use of the software. You may not rent, lend or lease this software. You may however transfer the
software to another party permanently, if that party agrees to the terms and conditions of this
agreement. You may not retain copies of the software and it must be removed from your hard disk.
At this point your License is automatically terminated.

Termination

The License is effective until terminated. You may terminate the License at any time by destroying
the proprietary material. The license will also terminate if you breach any of the terms of the
license. You agree upon such termination to destroy the program together with all copies in any
form.

Limited Warranty

If the manual or CD are defective in materials or workmanship, assuming normal use, for a period
of 90 days from the date of purchase they may be returned to GSPNA who will replace them free of
charge. Please send details of your purchase and a receipt with your request for a replacement.
This does not affect your statutory rights.

Reverse Engineering

You may not alter, modify or adapt the software or accompanying materials. In addition you may not
translate, disassemble or reverse engineer the software.

Limitation of Responsibility

The program is sold “AS IS”, and specifically disclaims all other warranties, expressed or implied.
You assume the entire risk as to the selection, results and performance of the program. In no
event shall GSPNA be liable for any damages whatsoever (including damages for loss of data, loss
of business, goodwill or any other consequential losses of any nature) arising out of the use or
inability to use the Proprietary Material. The product is not guaranteed to be error free. GSPNA
operates an internet/web based technical support service which is available to help with your
problems in accordance with our support policies provided that the product has been registered
with us. The functions described in the manual, and the screenshots shown within it, may apply to
pre-release or companion versions of this product. The contents of the manual do not form part of
any contract to deliver such functionality.

Trademarks

GSP, GSPNA and the GSP and GSPNA logos are trademarks of Global Software Publishing, North
America, Inc. All other manufacturers’ trademarks are acknowledged.

Installation
Windows 98/Me/2000/XP

Place the CD ROM in your CD ROM drive. If the Windows Autorun feature is active on
your system, the installation program will automatically start.

If the Autorun feature is turned off, insert the CD into your CD ROM drive, select
Settings | Control Panel from the taskbar Start menu. Double click on Add/Remove
Programs and click on the Install… button.

Follow the instructions that appear on screen until the installation in complete.

The installer will place all the files necessary to run the program onto your computer’s
hard disk. A shortcut will also be created in an appropriate program group in the Start
Menu.

Technical Support
If you require assistance with this product, technical support can be obtained through
our website, by email, fax or using normal postal services.

Global Software Publishing, North America, Inc.
Technical Support
535 West 34th Street
New York
NY 10001
USA

Website: WWW.GSPNA.COM
Fax: 646-792-2112

In order to help our technicians deal with your enquiry, please supply the following
information.

• Product title and detailed description of problem - including error messages.
• Operating System (including version number).
• RAM Memory.
• Free Available Hard Disc Space. (C: Drive).
• Make and model of any specific video and sound cards - including drivers.

Included on this CD is a technical guide that will help you resolve the most commonly
encountered problems. These hints and tips are recommended reading for anyone
experiencing technical difficulty so please refer to these before contacting our support
department.



3D World Atlas

1. Use of menus and menubar

1. 1. Main Menu

The main menu is displayed when "3D World Atlas" starts up. Choose one of the five
maps, one of the six geographical topics, or one of the countries from the drop down
list.

1.2. Functions Menu

The functions menu is located at the top of the screen and is always available. Here,
you find the following functions:

File
Print: prints the current map, or, in the case of a country or topic page, the current text
and images.
Exit: quits "3D World Atlas". You can also quit the program by clicking the small cross
at the top right of the screen.

Edit
Copy: copies the current map, or, in the case of a country or topic page, the current
text and images. These can be pasted into other suitable applications.
Select all: selects all of the current text and images that is open in a window.

View
Show/hide globe control : toggles the globe control window (only the currently open
map)
Show/hide locator: toggles the find location window (only the currently open map)
Show/hide measure tool: : toggles the measure tool window (only the currently open
map)
Main menu: goes to the main menu.
Status bar: toggles the status bar.

Bookmarks
Add bookmark: saves a view of a map. You can give the view a name in the dialogue
window. To open it again, click on the listing under the 'Bookmark' menu.
Delete bookmark: deletes a saved bookmark.

User labels
Add: add your own label to the map. Choose the icon and position on the map. Click
on the map to add the new label to the location. In the dialogue you can name the new
label.
View: shows all the user labels. Choose the label with a mouseclick. Then click OK.
The map will center on the chosen location. Click on 'edit' or 'delete' to work with the
label.

Help
About Atlas: opens a version of this document within the program.



2. Using the globe

The maps in "3D World Atlas" are projected as a globe. These can be zoomed in or
out, moved up and down, or turned by using the mouse, on screen controls, or
keyboard commands. With the location finder you can display any place or physical
feature.

2.1. Navigation

- Moving the globe from north to south and from east to west..

- Continuous zoom to the minimum distance from the surface..

The short pauses during a zoom sequence are necessitated by data loading..

2.2. Globe Control

Navigation can be done by using the mouse, keyboard commands or onscreen globe
control. The globe control is in four sections: control, display options, legend and
location finder. These four sections can be accessed via the symbols at the top of the
globe control window.

In the bottom part of the globe control, you can access all the globes, all topics, and all
country information. Click on one of the five small globes, to change map. The options
are: General map, Satellite map, Physical map, Bio-climatic map, and earth by night.



A: Control:

- The mini-globe can be moved in any direction you choose. The main globe will follow
the direction of the min-globe, and reposition itself.

- Turning the globe: click on the little arrows to the right of the mini-globe, to turn the
globe north, south east or west,. The inner arrows turn the globe continually, while the
outer arrows turn it in small steps.

B: Display options

- With the help of the yellow arrows, you can move the globe right to left and up and
down.. A mouseclick on the word 'center' or the cross in the middle of the yellow
arrows will center the globe again.

- Checking the boxes underneath the control globe enables you to choose which
geographical features to display on the current globe.:

Shadow - toggles a 3D shadow effect on the globe

Grid - toggles the latitude and longitude grid on/off

Labels - toggles all labels on/off.

Underneath you find all of the checkboxes for geographical features

Note that labels are visible only when the correct zoom level is reached. So, for
example, a small town name will not be visible from a long way away.



C. Legend:

The legend button opens the legend for the current map.

D. Location finder:

Clicking the icon at the top right of the window opens the location finder dialogue box
(see 2.4.).

2.3. Control with the mouse

You can also control the globes using the mouse.:

Rotating the globe
Drag the mouse over the globe with the left button pressed. The more you drag, the
faster the speed of rotation.

Zoom in and out
To zoom in hold down the ctrl key and drag the mouse. To zoom out hold down the alt
key and drag the mouse.

Move the globe
Drag the mouse over the globe with the right button pressed.

Moving the mouse over the map displays the latitude and longitude coordinates in the
status bar to the bottom right.

2.4. Location finder

"3D World Atlas" contains an alphabetical index of all the geographical features on the
map..

Click on the "flag" symbol in the top right of the globe control window. Or choose the
option 'view locator' from the 'View' menu in the menubar.



Finding a location

Choose a feature type from the upper dropdown menu. This applies a filter to the
complete list of features.

Spell out the letters of the feature you want to locate. The program automatically lists
the items nearest to the letters you have typed in.

Click the OK button - or double click the chosen entry, to center the map on your
selected location.

If your chosen location is not visible on the map, check that you have the display
option for that feature set activated. Go to the 'Display' window and review the
checkboxes available there.

2.5. Location information

Click with the left mouse button on the map to display information about a location.
You can click on a place or a landmass. As well as the standard information, there is
more information available by clicking on the small blue arrow.

2.6. Printing maps

To print the maps choose the 'Print' option from the 'File' menu, or press ctrl+P.
The maps will be printed how they appear on the screen.

2.7. Copying maps

To copy maps choose 'Copy' from the 'Edit' menu on the menubar, or press ctrl+C.
The map will be copied to the clipboard. The map is now available to be pasted into
other applications.

Warning:
The maps in "3D World Atlas" are copyright protected. You may copy the maps for
private use, but they may not be distributed..

 3. Using the topic pages

The topics are divided into headings. "Contents" are listed in the dropdown menu to
the top right of each page..

Hyperlinks to the maps

At the end of most topics pages, there are links to sample locations on the map.



Printing topics pages

To print the topics page choose the 'Print' option from the 'File' menu, or press ctrl+P.

In the Windows printing dialogue, choose 'All frames individually' if you want the text
and images to appear as they do on the screen.

Copying topics pages

To copy maps choose first select the text you wish to copy, then choose 'Copy' from
the 'Edit' menu on the menubar, or press ctrl+C. The text will be copied to the
clipboard. The text is now available to be pasted into other applications.

Warning:
The text and images in "3D World Atlas" are copyright protected. You may copy the
maps for private use, but they may not be distributed..

4. Using the country menu
"3D World Atlas" contains data and information about all the countries of the world.

Choose a country or territory from the dropdown menu on the home page, or in the
globe control window.

Please note that dependent territories are listed at the end of the main country list.

In the information window of a country you see an overview of the country facts and
figures. Further information is divided into sections, which are accessed using the
menu to the left of the window.

Clicking on the 'map' button centers the globe on the current country.
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NATURAL DISASTERS

Earthquakes
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kobe.jpg NOAA/NGDC Photo
lomo.jpg D. Perkins, USGS Photo NOAA/NGDC
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turkey.jpg NASA/GSFC Landsat 7 ETM

Volcanoes
mthood.jpg Philip Eales Photo
hawaii1.jpg G. E. Ulrich, USGS Photo NOAA/NGDC
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Forest fires
idaho.jpg NASA/GSFC Terra MODIS
hanford.jpg NASA/GSFC Landsat 7 ETM
fires2.jpg Philip Eales Photo
fires1.jpg Philip Eales Photo

Global climate
blizzard.jpg NASA/GSFC Terra MODIS
flooding1.jpg T. J. Casadevall, USGS Aerial NOAA/NGDC
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deccan.jpg NASA/JSC Space Shuttle-Foto
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ENVIRONMENT
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Climate change
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Forest clearance
burning.jpg NASA/JPL AVIRIS
sediment.jpg NASA/JSC Space Shuttle-Foto
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rondonia.jpg USGS Landsat MSS
borneo2.jpg NASA/GSFC Terra MODIS

Desertification
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owens.jpg NASA/JSC Space Shuttle-Foto
imperial.jpg NASA/JSC Space Shuttle-Foto
aral.jpg NASA/JSC Space Shuttle-Foto

Industrial pollution
angeles.jpg NASA/JSC Space Shuttle-Foto
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kuwait.jpg NASA/JSC Space Shuttle-Foto
chernobyll.jpg NASA/GSFC Landsat TM

BIO-CLIMATIC ZONES
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tundra.jpg Philip Eales Photo
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needle.jpg Philip Eales Photo
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fresh120.jpg Planetary Visions Sat image
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cares.jpg Philip Eales Photo

Plains
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desert2.jpg Philip Eales Photo
desert3.jpg Philip Eales Photo
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oases.jpg Philip Eales Photo
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rocks.jpg Philip Eales Photo
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WA_cape_01.jpg NASA
WA_cape_02.jpg NASA
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00692.jpg NASA/JSC Space Shuttle-Foto
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Additional sources:
NASA - National Aeronautical and Space Administration
GSFC - Goddard Spaceflight Center
JSC - Johnson Space Center
JPL - Jet Propulsion Laboratory
NOAA - National Oceanic and Atmospheric Administration
NGDC - National Geophysical Data Center
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